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Introduction

This document covers installation and operation of the

Communication Interface Module (CIM) and THS 2000

Software for the TSC 800 transfer switch controller. A

Table of Contents appears on the last page.

These instructions apply to Version 3.0 of the

Communication Interface Module (CIM). For other

product versions, contact the manufacturer to obtain

applicable instruction manuals.

The remote communication system with the CIM 3.0

andModbus� protocol provides remote monitoring and

control of TSC microprocessor-based controllers as

used in the power generation industry. The system

consists of two main components as follows:

1. Communication Interface Module (CIM): The CIM

provides the hardware and software interface

between a Modbus�-compliant device (customer-

supplied) and the specific microprocessor-based

controllers as used at a generator site.

2. Remote Terminal Unit (RTU): An RTU is a device

that directly operates the equipment at a generator

site. These devices are the actualmicroprocessor-

based controllers (e.g. TSC 800 transfer switch

controller).

Figure 1 depicts a typical remote communication system.

Some advanced features of the remote communication

systemwith the CIM 3.0 module andModbus� protocol

are as follows:

1. One CIM module can control and monitor up to 10

RTUs at a generator site using a single direct

serial/phone link.

2. Configuration of all communication system

setpoints is done using software.

3. CIM Port #2 can be configured for RS-232,

RS-422, or RS-485 serial communication types.

RS-485 communication allows multiple CIMs to be

interconnected to any Modbus� RS-485 network.

RS-485 is recommended for the best distance and

noise immunity. Port #2 has a hardware protocol

auto-detection option that removes the confusion

of determining whether the port is in RS-232 or

RS-485 mode. Just plug in and communicate

(assuming the baud rate etc. is set correctly).

8 conductor shielded cable c/w
RJ45 connectors

305 m
(1000 ft.)*
maximum

cable length

DC power
8--35 VDC

RS 232 signal
15 m (50 ft.)*
maximum

cable length

Personal
Computer

Phone

Port 2A Port 3B

null modem

connector

no

connection

*Communication cable wiring must be suitably routed to protect it from
sources of electrical interference. Refer to installation section for further
information
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Figure 1 RTU Site

Modbus� is a trademark of Schneider Electric.
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4. Security features have been implemented to allow

password protection. However these features

along with auto-detection and modem functionality

can be bypassed with a fixed Modbus� option that

is intended for direct PLC function where remote

access is not necessary.

5. With onboard modem support, CIM 3.0 offers

remote telephone connectivity with auto callout

and pager support with up to 32 characters. Up to 3

phone numbers can be programmed into the CIM

for remote THS software connection or pager

notification. In the case of a failed connection,

retries can be specified.

Note: Throughout this document, CIMs and TSC 800s

are generically referred to as remotes.

Further information on the Modbus� protocol support

on theCIM can be found in Section 3 and at theModicon

website (www.modicon.com).

Safety Precautions

Observe the following safety precautionswhile installing

the kit.

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can
cause severe injury or death. Before working on the
generator set or connected equipment, disable the generator
set as follows: (1) Move thegenerator setmaster switch to the
OFFposition. (2) Disconnect thepower to thebattery charger.
(3) Remove the battery cables, negative (--) lead first.
Reconnect the negative (--) lead last when reconnecting the
battery. Follow these precautions to prevent starting of the
generator set by an automatic transfer switch, remote
start/stop switch, or engine start command from a remote
computer.

Hazardous voltage.
Will cause severe injury or death.

Only authorized personnel should
open the enclosure.

DANGER

Hazardous voltage.
Will cause severe injury or death.

Disconnect all power sources before
opening the enclosure.

DANGER

Servicing the transfer switch. Hazardous voltage can
cause severe injury or death. Deenergize all power sources
before servicing. Open themain circuit breakers of all transfer
switch power sources and disable all generator sets as
follows: (1) Move all generator set master controller switches
to the OFF position. (2) Disconnect power to all battery

chargers. (3) Disconnect all battery cables, negative (--) leads
first. Reconnect negative (--) leads lastwhen reconnecting the
battery cables after servicing. Follow these precautions to
prevent the starting of generator sets by an automatic transfer
switch, remote start/stop switch, or engine start command
from a remote computer. Before servicing any components

inside the enclosure: (1) Remove all jewelry. (2) Stand on a
dry, approvedelectrically insulatedmat. (3) Test circuitswith a
voltmeter to verify that they are deenergized.
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1 Communication Interface Module

1.1 CIM Specifications

� Power supply: 8 to 35VDC, negative ground

� Power consumption: 5 watts (max.)

� Operating temperature: --15°C to 50°C (5°F to

122°F)

� Storage temperature: --40°C to 85°C (--40°F to

185°F)

� Environmental: NEMA 1

� Vibration: 1 g, 5--250Hz

� Humidity: 5%--95% noncondensing

� Dimensions, W x H x D, mm (in.): 150 x 180 x 50

(5.91 x 7.09 x 1.96)

� Internal Modem 14.4k baud, Hayes� AT set

compatible

� Communication Ports Hardware Port 1 Telephone

T/R Port 2 RS-232/-422/-485 asynch.,

1200--19200 baud Port 3 RS-422, asynchronous

4800 baud

� Communication Ports Software Protocol:

� Port 1: Telephone

� Port 2: Modbus� Protocol

� Port 3: TTI T-Net Protocol

Specifications are subject to change without notice.

1.2 CIM General Description

The Communication Interface Module (CIM) is an

advanced communication interface device for remote

communication to the latest generation of

microprocessor-based engine generator and transfer

switch control products. One CIM module can

communicate with networked TSC 800 transfer

controllers. The serial communication ports can be

used for direct connection to a personal computer (port

#2) or to other remote connected devices (port #3). An

internal modem is available with the CIM, which

provides direct connection to a telephone system.

The CIM provides the following advanced features:

1. Dedicated microprocessor-based design provides

fast operation without restricting RTU operation.

2. One CIM module can provide interface to a

complete networked RTU system. This leads to a

single telephone line connection per site rather

than typical multiple line solutions.

3. Internal 14.4k baud modem available for direct

connection to telephone system.

4. Flexible design provides two fully configurable

serial ports.

5. Standard plug-in telephone RJ45/RJ11 type jacks

and DB9 computer ports provide simple

interconnection to system.

6. The ability to callout to a software host station or

pager when an RTU fault occurs frees the user

from continual monitoring. It also allows for

immediate remote response to problems.

1.3 CIM Hardware Interface

The main features of the CIM are described in the

following sections with reference to Figure 2.

1.3.1 Port 2B

Port 2B may be interconnected to an RTU or Personal

computer (PC). Port 2B can be configured to RS-232 or

RS-485/-422 type transmission signal. When a

personal computer is connected to Port 2B, a null

modem cable or connector must be used. When the

CIM modules’ internal modem is used, port 2B is

disabled. This port uses an 8-pin RJ45 plug-in

connector. An LED indicator is provided to signal when

the port is communicating. Port 2B is internally wired in

parallel with Port 2A.

1.3.2 Port 2A

Port 2A may be interconnected to an RTU or PC. Port

2A can be configured to RS-232 or RS-485/-422 type

transmission signal. When a personal computer is

connected to Port 2A, a null modem cable or connector

must be used in series with the PC cable. When theCIM

modules’ internal modem is used, port 2A is disabled.

This port uses a 9-pin standard DB9 female plug-in

connector. An LED indicator is provided to signal when

the port is Transmitting. Port 2A is internally wired in

parallel with Port 2B.
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Figure 2 CIM Features

1.3.3 Port 3B

This port may be interconnected to an RTU. Port 3B

utilizes an RS-422 type transmission signal that is

compatible with TSC 800 controllers. The standard

connection for a TSC 800 controller (RTU) application is

for port 3B to be connected to the RTU. This port uses

an 8-pin RJ45 plug-in connector and allows for a direct

connection to TSC 800 controller. Port 3B is internally

wired in parallel with Port 3A.

1.3.4 Port 3A

This port may be interconnected to an RTU or directly to

a PC. Port 3A utilizes an RS-422 type transmission

signal that is compatible with TSC 800 controller. The

standard connection for a TSC 800 controller (RTU)

application is for port 3A to be connected to the RTU.

This port uses a 9-pin DB9 female connector. Port 3A is

internally wired in parallel with Port 3B.

Note: CIM Port 2 cannot be used concurrently with the

modem (CIM Port 1). An RS-232 or RS-422

cable can be connected to the CIM, but cannot be

active if the modem is to be used. An RS-485

connection will effectively disable the modem

whether it is active or inactive.

1.3.5 Internal Modem

The CIM is provided with an internal 14.4k baud

modem. The modem is internally connected between

the telephone port and port 2A/B.

1.3.6 Diagnostic LEDs

The CIM module provides diagnostic LED lights are

described as follows:

1. Power: This LED is illuminated whenever the CIM

has correct DC supply voltage applied.

2. Service: This LED illuminates when the CIM has

an internal fault in which the unit must require

service.

3. DC Fault: This LED is illuminated whenever the

CIMs internal power supply has shut down due to

an internal fault or an external overvoltage

condition from the DC supply input. To reset a DC

fault, the DC supply voltage must be removed for

30 seconds, then reapplied.
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1.3.7 Telephone Port

The telephone port is used to interconnect to a

telephone system. This port is internally connected to a

14.4 Chased modem. This port uses a 6-pin RJ11

plug-in jack connection.

1.3.8 DC Power Input

Terminals are provided for DC power input to the CIM

module. Power input is non-polarity sensitive and can

range from 8--35 VDC.

1.4 Telephone Port 1

Detail pin numbers and usage designations for the

telephone port are shown in Figure 3.

1.5 Port 2A/B

Detail pin numbers and usage designations for Port

number 2A/B are shown in Figure 4.

1.6 Port 3A/B

Detail pin numbers and usage designations for Port

number 3A/B are as listed in Figure 5.

Port 1A RJ11 No.
Signal Type,
Telephone Direction

1 No Connection No Connection

2 No Connection No Connection

3 TIP Input/output

4 Ring Input/output

5 No Connection No Connection

6 No Connection No Connection

Figure 3 Telephone Port

RJ45 No. DB9 No.
RS-485 Half-Duplex
(pending)

RS-422 Full-Duplex
(pending) RS-232 (DTE) Direction

1 1 Sa’ Rxa CD Input

2 2 Sb’ Rxb Rx Input

3 3 Sb Txb Tx Output

4 4 Sa Txa DTR Output

5 5 Ground Ground GND Passive

6 6 NC NC DSR Input

7 7 NC NC RTS Output

8 8 NC NC CTS Input

N/A 9 RI N/C

Figure 4 Port 2 A/B

RJ45 No. DB9 No. RS-485 Half-Duplex (pending) RS-422 Full-Duplex (pending) RS-232 (DCE) Direction

1 1 Sa Txa CD Output

2 2 Sb Txb Tx Output

3 3 Sb’ Rxb Rx Input

4 4 Sa’ Rxa DSR Input

5 5 Ground Ground GND Passive

6 6 NC NC DTR Output

7 7 NC NC CTS Input

8 8 NC NC RTS Output

N/A 9 RI N/C

Figure 5 Port 3 A/B
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Figure 6 CIM Block Diagram

1.7 CIM Operation Functions

The CIM module provides the following main functions

when used in a communication system:

1. RTU and Modbus� Device Interface: The CIM is

the main communication interface component

between a Modbus� compliant device and the

remote terminal units. The CIM provides the

necessary hardware interface (i.e. COM Ports) as

well as the Modbus� software protocol interface.

2. Protocol Data Processing: The CIM receives

incoming communication signals from various

types of RTUs and processes the data into the

specific Modbus� language as required for the

application. The processed data then gets

transferred to the applicable port and transmitted to

a remote Modbus� compliant device.

3. CIM Configuration: The CIM stores vital

information in non-volatile FLASH memory

pertaining to a specific RTU site as defined by the

user. Stored information includes, site name, site

passwords, and auto callout phone numbers (3).

4. RTU Polling: The CIM module will automatically

poll connected RTUs to determine their operating

status and to signal an auto callout (callout is only

operational when the modem feature is

operational) to the remote Modbus� compliant

device to alert a user of an abnormal condition.

Modbus� is a trademark of Schneider Electric.

1.8 CIM Installation

Hazardous voltage.
Will cause severe injury or death.

Only authorized personnel should
open the enclosure.

DANGER

Hazardous voltage.
Will cause severe injury or death.

Disconnect all power sources before
opening the enclosure.

DANGER

Note: Installations must be done according to the NEC

and all applicable electrical regulation codes.

The following installation guidelines are provided for

general information only pertaining to typical site

installations. For specific site installation information,

consult the manufacturer as required.
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Trained and qualified personnel must install and service

the CIM.

1.8.1 Battery Supply Input

The CIM can operate on any battery supply from

8--35VDC nominal. Wiring from the system battery to

the CIM should conform to the following guidelines to

avoid possible communication module malfunction

and/or damage.

Avoid wiring from the engine start terminals; wiring

should go directly from the battery terminals to the

control panel where the CIMmodule is located (to avoid

voltage drop in the starter cables and starter motor

commutation noise).

Note: The battery charger must be turned off before

battery cables are removed from the battery (i.e.

for servicing). Failure to do so may subject the

control panel to an overvoltage condition in which

damage may result.

Under noisy environments (i.e. as engines with high

voltage ignitions, etc.), wiring from battery should be a

twisted pair of #14 AWG (2.5 mm2) wires.

The use of AC or DC operated solenoids or relays in

control systems can sometimes cause high voltage

spikes on the DC power supply, which may cause

electronic devices to fail. Transient suppression

devices are recommended for all inductive devices

sharing wiring or if physically located near the CIM

module. For DC operated relays or solenoids, use a

suitably rated counter EMF diode (or commonly known

as freewheeling diode). For AC operated relays or

solenoids, use a suitably rated metal oxide varistor

(MOV) or capacitor/resistor suppressor.

1.8.2 Remote Communication Wiring

All communication interconnecting wiring to/from the

CIM Module shall utilize #22 AWG-8 wire, twisted,

shielded cable with RJ45 connectors.

All remote communication wiring outside the control

panel must be run in separate conduit and shall not be

located near AC power cables to prevent pickup of

induced voltages.

1.8.3 Dielectric Testing

Do not perform any high voltage dielectric testing on the

CIM connected in the circuit as serious damage will

occur to the module.

1.8.4 Mounting Location/Installation

TheCIMModule is designed formounting directly onto a

control panel inner subpanel. Considerations should be

given for the following:

1. The controller should be installed in a dirt free, dry

location away from extreme heat sources.

2. Adequate space should be provided around the

CIM module for control wiring.

1.8.5 Mounting Dimensions

The CIM mounting dimensions are shown in Figure 7.

Figure 7 Mounting Dimensions
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1.8.6 RS-232 and RS-485422 Wiring

This section describes the cabling necessary to connect

a host PC to a CIM using RS-232 and to connect to an

RS-485 or RS-422 network.

Host PC Connection

The host PC connection to the CIM requires a

null-modem adapter, as both devices believe they are

DTE. See Figure 8 and Figure 9.

DTE DB-25 DB-9 CIM

GND 1 n/c GND

TXD 2 2 RXD

RXD 3 3 TXD

RTS 4 8 CTS

CTS 5 7 RTS

DSR, DCD 6, 8 4 DTR

SG 7 5 SG

DTR 20 6, 1 DSR, DCD

Figure 8 Host PC DB-25 To CIM DB-9

DTE DB-9 DB-9 CIM

TXD 3 2 RXD

RXD 2 3 TXD

RTS 47 8 CTS

CTS 8 7 RTS

DSR, DCD 1, 6 4 DTR

SG 5 5 SG

DTR 4 6, 1 DSR, DCD

Figure 9 Host PC DB-9 To CIM DB-9

RS-485/-422 Connection

The following hardware configuration is required for

4-wire RS-485/-422 from port 2 on theCIM to anRS-232

port on a computer:

� The following parts are connected in order from the

RS-232 side (computer) to the RS-485/-422 side (the

CIM).

� RS-232 to RS-485 or RS-422 adapter (set to DCE)

� DB-25 to RJ45 adapter (or custom cable) for

RS-422/-485 on the CIM port 2(see below wiring).

Ensure that the correct handshaking signals are

connected on the RS-232 side of the RS-485/-422

converter. Many RS-485 converters use the RTS line to

control the transmitter (which must be tristated during

receive mode). It is important to insure that the

converter is configured correctly and the correct

handshaking lines are wiring appropriately. If the

handshaking lines (RTS) are not wired correctly the

connection may appear to work but damage may occur

and communications may be unreliable over time. See

Figure 10 or Figure 11.

DB-25 from RS-422
Converter CIM Port 2

Signal Pin Pin Signal

TXB+ 14 1 RXB+

TXA-- 2 2 RXA--

RXA-- 5 3 TXA--

RXB+ 17 4 TXB+

GND (optional) 7 5 GND

Figure 10 RS-422 Handshaking

DB-25 from RS-485
Converter

CIM Port 2

Signal Pin Pin Signal

TXB+, RXB+ (jumpered) 14,
17

1, 4 RXB+,TXB+ (jumpered)

TXA--, RXA-- (jumpered) 2, 5 2, 3 RXA--, TXA-- (jumpered)

GND (optional) 7 5 GND

Note that the RS-232 side of the RS-485 converter will most likely
require the RTS line be connected along with TX, RX and GND.

Figure 11 RS-485 Handshaking
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1.9 CIM Troubleshooting

Service procedures must be undertaken by qualified

personnel only!

Hazardous voltage.
Will cause severe injury or death.

Disconnect all power sources before
opening the enclosure.

DANGER

Hazardous voltage.
Will cause severe injury or death.

Only authorized personnel should
open the enclosure.

DANGER

Servicing the transfer switch. Hazardous voltage can

cause severe injury or death. Deenergize all power sources
before servicing. Open themain circuit breakers of all transfer
switch power sources and disable all generator sets as
follows: (1) Move all generator set master controller switches
to the OFF position. (2) Disconnect power to all battery

chargers. (3) Disconnect all battery cables, negative (--) leads
first. Reconnect negative (--) leads lastwhen reconnecting the
battery cables after servicing. Follow these precautions to
prevent the starting of generator sets by an automatic transfer
switch, remote start/stop switch, or engine start command
from a remote computer. Before servicing any components

inside the enclosure: (1) Remove all jewelry. (2) Stand on a
dry, approvedelectrically insulatedmat. (3) Test circuitswith a
voltmeter to verify that they are deenergized.

1.9.1 Database Reinitialization

If state of the internal database is unknown a reset to

factory default conditions can be done by the following

procedure:

1. Remove power from the CIM.

2. Remove the CIM back cover.

3. Connect a wire from the CIM ground terminal

located next to the power connections.

4. Connect the other end of the ground wire to the test

point located on the bottom of the daughter board

(the daughter board is plugged into the bottom of

the CIMmotherboard) located on the bottom of the

CIM that should be visible with the bottom cover

removed.

5. With the bottom test point grounded carefully apply

power to the CIM for at least 2 seconds. You may

now remove power and reassemble the CIM. The

CIM has defaulted back to factory settings.

1.9.2 Troubleshooting Table

Refer to Figure 12. Consult the factory for any detailed

information or for any problems not listed. Read and

follow all safety precautions.
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Symptom Corrective Action

CIM does not power up even
with correct DC power applied.

Check that there are no wiring errors/short circuits connected to the CIM. Note: The CIM Module contains
an electronic fuse that triggers upon an overload or overvoltage condition and does not reset until the
supply voltage is removed.

Failure to communicate with
PC (di t t d)

Verify all communication cables are connected to the correct ports.
PC (direct connected).

Ensure that the RTU (TSC 800) is connected to Port 3 on the CIM.

When direct connection is used from port 2A to a PC, ensure a null modem cable or connector is used.
(see Host PC Connection in Section 2.6.3).

Verify all settings in the THS 2000 software program are correct. Critical settings are as follows:

Port 3 baud rate—4800.

Controller address—THS software setting and controller setting must match.

Site Name—THS software setting and CIM setting must match. Note: factory default setting in CIM is
”site.”

Site Password—THS software setting and CIM setting must match. Note: factory defeat setting in CIM is
”user.”

RTU site may be busy calling out if an alarm condition is present on the controller. Reset all fault
conditions at the controller and set for automatic mode to cancel the auto call out condition.

Failure to communicate with
PC ( d t d)

Verify PC modem operates correctly (test independently with another software system).
PC (modem connected).

Verify PC modem is set for 9600 baud operation.

Ensure phone numbers programmed for both PC site location and RTU equipment location are correct.

Failure to communicate with
PC.

If you encounter difficulty connecting to a CIM with the Host software make sure the CIM is not trying to
callout. When the CIM is trying to callout to the Host sites it will not respond to outside requests for
connection. In this situation the user can be patient and make repeated attempts at connection until the
CIM has exhausted its phone numbers and retries (can be over 12 min. in some cases with 3 numbers and
3 retries). Or the user can let the host successfully callout to the Host software. After the phone numbers
are successfully attempted or retries are exhausted the CIM will go back into a log-in ready state. If time is
important, the CIM may be power cycled, for a brief time after the CIM power is restored (after the 2 quick
blinks on the Port 2 LED) the CIM will be log-in ready. However the CIM will eventually go into a callout
state to report the site alarm situation.

The above situation is the most common cause for not being able to establish a connection to the CIM.
For testing and configuration it is recommended that the callout function be disabled until it is required, this
will eliminate the frustration described above.

Site RTU fails to auto callout to
PC.

Verify the connected controller is programmed for the specific auto callout function (i.e. common alarm,
common shutdown or common fail).C

Verify the Host software is in auto answer mode, see Section 2.6.6, Auto Answer Configuration.

Port configuration changes do
t k

The CIM port configuration changes will not go into effect until the CIM has been power cycled.g g
not work.

For Modbus� communications ensure that the CIM is being addressed with the correct node address.
The factory default CIM node address is ’1’, this should not be confused with the RTU node addresses
connected to Port 3 of the CIM.

Figure 12 CIM Troubleshooting
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2 THS 2000 Software Program

The THS 2000 software program remotely controls and

monitors a transfer switch control system. The THS

2000 program operates on an IBM-compatible Personal

Computer with the following operating systems:

� Microsoft Windows 95�

� Microsoft Windows 98�

� Microsoft Windows NT� 4.0

� Microsoft Windows 2000

The THS 2000 software program uses a manufacturer-

designed protocol to communicate to TSC 800 ATS

control system. A site consists of a single

Communication Interface Module (CIM) and one or

more associated Remote Terminal Unit (RTU)

controllers.

The THS 2000 software is designed to allow a direct

connection (via RS-232, RS-422 or RS-485) to Port 2 of

the CIM or a remote connection (via a host PC modem)

with the internal modem of the CIM on Port 1. The host

PC modem must already be configured before

attempting a remote connection. See the operating

system help for installing and configuring modems.

Version 3.1 of the THS 2000 software is intended for

operation with Version 3.0 of the CIM, but also provides

support for previous versions of the CIM.

2.1 Definitions

Item Definition

CIM Communications interface module; the
communications hub for a site.

Dialog box Interactive window allowing the user to view or
change settings.

Modbus� Industry-standard serial automation protocol
defined by Modicon, part of Schneider Automation,
Inc.

RTU Remote terminal unit; in this context, a TSC 800.

TSC 800 Transfer switch controller

Site CIM and one or more connected RTUs,

Site list List of remote sites, primarily used for auto answer
and multiple CIM sites.

2.2 Improvements

A number of improvements have been made to this

version of the THS 2000 software. Most of the

improvements correspond to added features of CIM

Version 3.0, but some of the changes are applicable to

the previous version of the CIM. See Communication

Interface Module for more information on device-

specific features and Section 3, CIM Protocol, for the

Modbus� protocol.

The most notable improvement is the use of the

Modbus� protocol for communications to the CIM.

The new features in THS 2000 software are:

� Support for new CIM 3.0 Modbus� protocol as well

as previous CIM protocol versions.

� Automatic RTU (TSC 800) discovery on logon. This

will eliminate the need for the user to program the

individual node address and controller type for each

site (CIM). See Controller Discovery in Section 2.6.5.

� Support for these additional CIM 3.0 features:

� 32 character telephone numbers for callout (see

Section 2.6.6, Auto Answer Configuration).

� Call all numbers option for CIM callout (see

Section 2.6.6, Auto Answer Configuration).

� CIM Port 2 auto-detect feature for the hardware

protocol (see CIM Port 2 in Section 2.6.4).

� Bounded controller addresses for faster detection

(see CIM Advanced in Section 2.6.4).

� CIM Port 2 can now be configured for speeds from

1200 bps up to 19.2 KB/sec., instead of being fixed at

9600 bps. This works for old CIM versions as well.

� Support for multiple remote callout sites. THS

Versions 1.0 and 1.1 software only support auto

answer for a single site. A system with two CIM sites

that can call out would not work correctly. This has

been fixed by adding multiple sites to a single THS

2000 software file. The calling-in CIM is then

identified from the loaded set of sites. See Section

2.6.2, Site List Management.

� Improved communications reliability over noisy

communication lines.

THS 2000 Version 3.1 software adds the ability to

connect directly to an RTU, bypassing the CIM. A

maximum of one RTU or TSC 800 is allowed. The auto

answer feature of THS 2000 software is not supported in

this mode, as it is a function of the CIM. The auto

discovery of controllers is likewise not available. See

Section 2.8, CIM Bypass Wiring, for a wiring

description.

Modbus� is a trademark of Schneider Electric.
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2.3 Computer System Requirements

The supported operating systems are:

� Microsoft Windows 95�, Service Release 2 or later.

� Microsoft Windows 98�.

� Microsoft Windows NT� 4.0 Workstation or Server,

Service Pack 3 or later.

� Microsoft Windows 2000.

A minimum of 2 MB of hard drive space on the chosen

installation drive is necessary for proper operation.

Amodem that is fully supported by the operating system

is required for remote operation. It is important that the

correct modem driver software is installed correctly.

An FIFO-enabled serial-port is required for direct

connections.

Microsoft Internet Explorer� 4.01 or later is

recommended for use with the online help. However,

Microsoft Internet Explorer 3.02 is sufficient if the

hhupd.exe file, included with the THS 2000 software

distribution, is run first; this executable is provided by

Microsoft for updating help file support.

2.4 Installation

The THS 2000 software consists of two files, the

THS3v0.EXE file and the THS3v0.CHM file. Copy both

files to a directory on your hard drive, such as C:\THS.

The first file, THS3v0.EXE, is the THS 2000 executable.

You can make a link to this file on your desktop by

dragging and dropping the THS3v0.EXE from the

explorer to the desktop. The second file, THS3v0.CHM,

is the online help file.

If you are using Microsoft Internet Explorer 3.02, the file

hhupd.exe will be required to execute and update a

system file for HTML Help support. That file is not

required if Microsoft Internet Explorer 4.01 or later is

installed.

2.5 Quick Start

This section will get you up and running the THS 2000

software quickly and easily and covers the simple tasks

that are necessary to communicate with a site. More

advanced topics will be covered in a later section.

1. Start THS 2000 software.

Double click on the THS 2000 icon (THS3v0.EXE)

to start the program. See Section 2.4, Installation.

2. Logon.

The Password dialog box will appear as shown in

Figure 13. Type in your password and click theOK

button or just click the OK button if you have not

programmed any passwords yet. There are no

passwords configured initially, so click on OK to

continue if you are running for the first time.

See Section 2.6.1, Passwords, and Starting and

Logging On in Section 2.7.1.

Figure 13 Password Dialog Box

3. Set host connection method.

Select the Connect command from the Site menu

(or toolbar button or press F9 ). This command will

normally bring up a list of accessible sites;

however, if no sites are defined, youwill be required

to choose a host connection method. This dialog

box in Figure 14.

Figure 14 Host Connection Dialog Box
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Select your connection method, either a specific

modem (e.g. Hayes Accura 288 V.34 + FAX) or a

serial port (e.g.Direct using COM1). If you select a

direct communications port, you are also able to

modify the port settings. The default settings are

likely sufficient for now, so click the OK button.

See Host Connection in Section 2.6.3.

4. Enter site properties.

Once the connection method is established, you

will be prompted for the site properties, such as site

name, as shown in Figure 15. This allows you to

enter the first site in the site list.

Figure 15 Site Properties

The name and password fields correspond to the

name and password already programmed into the

CIM that is managing the remote site. The

description field is optional and can be used to

describe the site. The phone number is entered for

a remote site.

The name and password parameters must match

the CIM on the intended site. The default name is

site and the default password is user. These

parameters are case insensitive. See Site

Properties in Section 2.6.3.

5. Connect to site.

The next dialog box displays the list of sites, as

shown in Figure 16. At this point, there is only one

site and it’s already selected. From this dialog you

can add, remove andmodify site properties;modify

the connection method; and connect to the

selected site. Clicking on the Connect button will

begin the connection process. If you experience

problems connecting to the remote site, please

refer to Section 2.9, Troubleshooting. See

Connecting A Site in Section 2.7.2.

Figure 16 Connect to Site

6. Identify controllers.

Once you are connected to the remote site, you

need to identify the controllers on the site. If you

are running CIM 3.0 or higher, the THS 2000

software will offer the controllers that have already

been discovered, as shown in Figure 17. You

merely need to accept the controller list to have

them added to the site. If you are running an older

CIM, you must identify and add the controllers

manually; see Adding AController in Section 2.6.5.

At this point, you are connected and

communicating with the CIM and its controllers.

The status bar at the bottom of the window will

flicker and display a message similar toConnected

to EastWing.

Figure 17 Controller List

7. View controller data.

A set of buttons at the top of thewindowwill contain

the word List and the number of each controller.

This is the Controller Bar. Clicking a button on the

Controller Bar selects the current view in the main

part of the window. The list-view is a list of all the

controllers and the controller views are

representations of an individual controller.
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When the selected site is connected, the dot in the

middle of the controller bar button will indicate the

status of the controller (green, yellow, red, or

black).

See Controller Views in Section 2.7.3.

8. Issue controller commands.

Once connected to a site, commands can be

issued to controllers through the TSC 800

Commandmenu items under the Controllermenu.

See Controller Commands in Section 2.7.3.

9. Save/restore site list information.

The current site list can be saved by using theSave

or Save As commands under the File menu or the

toolbar button.

A previously saved site list file can be retrieved

using theOpen command from theFilemenu or the

numbered recent file list under the Filemenu or the

toolbar button.

See Saving A Site List and Opening An Existing

Site List in Section 2.6.2.

2.6 Configuration

The THS 2000 software allows the configuration of

passwords, lists of sites, the CIM, and the auto answer

feature. Configuration of THS 2000 software site lists

and other parameters is generally done once and then

used many times in an operational capacity.

2.6.1 Passwords

The THS 2000 program can be secured with the use of

passwords. The password levels are:

1. ReadOnly. The read only user can only monitor an

RTU site and may not change any settings or

modes of operation.

2. Read/Write. The read/write user can monitor an

RTU site andmay change any settings or modes of

operation as desired.

3. Master. Themaster read/write user canmonitor an

RTU site andmay change any settings or modes of

operation as desired. The master read/write user

can also view or modify the lower-level security

passwords.

The Options item under the Toolsmenu will present the

user with master security level with a choice that allows

the passwords to be modified, as shown in Figure 18.

For a user with less than the master security level, that

menu item is grayed-out.

Figure 18 Tools—>Options—>Passwords (master

security level required)

The site passwords are normally shown as a series of

asterisks (*), but can be shown in actual letters by

enabling the show-site-password check box.

2.6.2 Site List Management

THS 2000 software allows you to create, save, and

reopen site lists. A site list is a collection of one or more

sites that are all accessed through the same host

modem. A site list can also be configured for auto

answer, allowing any of the listed remote sites to call

THS 2000 software in case of an alarm condition.

The list of sites, site properties, connection method, and

auto answer settings are all stored in the .THS file. This

file can be created, opened, and saved from THS 2000

software.

Creating A New Site List

A new site list can be created using the New command

from the File menu (or toolbar button). This command

will bring up the Site Properties dialog, as shown in

Figure 19, for the first site in the site list.

Figure 19 Site Properties Dialog Box
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The name and password fields correspond to the name

and password already programmed into the CIM that is

managing the remote site. All of the site names within a

site list must be unique. The description field is optional.

The phone number is entered for a remote site.

Opening An Existing Site List

An existing site list can be opened using the Open

command from the File menu (or the toolbar button).

This command will bring up the conventional Windows

dialog allowing you to select a file to open.

The File menu also stores the most recently used four

site list files. These can be opened directly by selecting

the file name from the File menu or using the shortcut

key sequence ALT-F followed by the number (1-4) of the

desired file.

Note: Files created by previous versions of THS 2000

software can be opened, but theywill only contain

a single site in the site list. If this file is modified

and saved, you will no longer be able to open it

from previous versions of THS 2000 software.

Saving A Site List

A site list can be saved to disk by using theSave orSave

As commands from the File menu (or the toolbar

button). These commands will invoke the standard

Windows dialog for saving a file.

Note: Files saved by this version of software will not be

readable by previous versions of THS 2000

software.

2.6.3 Site Configuration

Viewing andmodifying the site configuration begins with

the Connect item under the Site menu. This action will

produce the list of sites (see Section 2.6.2, Site List

Management), as exemplified in Figure 20. From this

dialog box, new sites can be added to the site list, sites

can be removed from the site list, or a site’s properties

viewed or modified. The host connection method can

also be viewed or modified. In addition, the site is

connected (see Connecting A Site in Section 2.7.2)

from this dialog.

Figure 20 Connect to Dialog Box

Adding A Site

Electing to add a site by clicking the Add button of the

Connect To dialog box will present you with the Site

Properties dialog box depicted in Figure 19. This allows

you to enter the name and password of the new site,

which is the name and password of the CIM on that site.

The description can be any descriptive text. The

phone-number can only be entered for a host

connection that is a modem (see Host Connection in

Section 2.6.3).

The password field is normally shown as all asterisks (*),

but can be made to display the actual letters (see

Section 2.6.1, Passwords).

Removing A Site

Clicking the Remove button of the Connect To dialog

boxwill cause THS2000 software to ask you if you really

want to remove the selected site. Choosing the

affirmative option will delete the selected site from the

site list.

Site Properties

Selecting the Properties button of theConnect To dialog

box will bring up the Site Properties dialog box, as in

Adding A Site (above), but with the details of the

selected site, as shown in Figure 21.

This dialog box can also be displayed by right clicking on

the name of the site in the site list dialog.
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Figure 21 Site Properties (with Details)

Host Connection

The host connection method can be changed from the

Connect Using command of the Site menu or the

Connect Using button of theConnect To dialog box (see

Connecting A Site in Section 2.7.2). This command will

bring up the Host PC Connection dialog box, as shown

in Figure 22.

Figure 22 Host PC Connection Box

In the list-box, you can select any modems or

communication ports that are recognized by the

operating system. Modems can be added and

configured in the Modem entry in the Windows Control

Panel (see the operating system documentation).

In THS 2000 Version 3.1 software, an additional option

allows THS 2000 software to bypass the CIM and

connect to a single controller or TSC 800. For a direct

connection using one of the serial ports, the baud rate is

automatically set to 4800 to match a direct controller

connection. The CIM bypass mode does not allow

THS 2000 to receive alarm callouts from the site.

If a direct communication port is selected, the Port

Settings button will be clickable. Selecting the Port

Settings button will bring up thePort Settings dialog box,

as shown in Figure 23, where advanced

communications parameters can be viewed and

modified.

Figure 23 Port Settings Box

Supported baud rates are 1200, 2400, 4800, 9600,

14400, and 19200. The Restore Defaults button set the

parameters to RS-232 signal type, no parity, 8 data bits,

1 stop bit, and 9600 baud.

The RTS activation is only applicable under RS-485.

This defines the level of the RTS line that is used by

RS-232 to RS-485 converters to signal a transmission.

Unless otherwise specified, this should be active high

for most converters.

These parameters must be matched to the Port 2

configuration of the CIM on the site (see CIM Port 2 in

Section 2.6.4).

Changes to the port settings do not take effect until the

site is reconnected.

2.6.4 Communications Interface Module
Settings

The heart of communications to a remote site is theCIM.

All the remote controllers and TSC 800s are attached to

this device. Normally, the CIM is not connected to the

host computer. The normal operation for the CIM is to

poll the status of each controller and attempt to discover

new controllers. When the status of a controller

indicates an alarm condition, the CIM can be

programmed to call the host and report that an alarm

condition exists.

When connected to a host computer running THS 2000

software, the CIM discontinues its polling and allows the

THS 200 software to interrogate the controllers.

The CIM can be configured by selecting the CIM

Properties item in the Site menu. This will bring up the

Current Site Properties dialog box. This window is a
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tabbed collection of dialogs that query and display

different parameters from the CIM, including the site

information, version, port configuration, and callout

phone numbers.

When a value is modified, the Apply button will become

clickable. Clicking the Apply button will send the

changes to the CIM. Also, clicking the OK button will

send the changes to the CIM if you answer yes to the

save changes question. Hitting the Cancel button will

abort any changes that have not yet been written. After

the new values arewritten to theCIM, they are read from

the CIM and displayed.

Some of the CIMs properties screens contain aRefresh

button that will simply re-read the data from the CIM.

For more information on the CIM, see Communication

Interface Module.

CIM Site

Selecting the CIM Site tab in the Current Site Properties

dialog box will produce a display similar to that shown in

Figure 24. TheF2 key (or the toolbar button) can alsobe

used to select the Current Site Properties dialog box.

From here, you can enter the site name and site

password that will be used by the site connection

described in Connecting A Site in Section 2.7.2.

Figure 24 CIM Site

The name and password fields have a maximum length

of 16 characters and case does not matter. CIM

versions prior to CIM 3.0 are limited to 12 characters for

the site name and 8 characters for the password.

Note: All CIMs that are intended for callout operation to

the same site list must have unique site names.

CIM Version

The CIM version tab simply reads and displays the

version information, including the serial number. This

may be useful for future compatibility issues and

service.

Note: CIM versions prior to Version 3.0 did not have a

serial-number or Modbus� support; these fields

appears as N/A when communicating with one of

these older devices.

CIM Callout

The CIM Callout tab configured the callout feature,

which allows the CIM to call the host in case of an alarm

condition. The dialog box is depicted in Figure 25.

Refer to Section 2.7.5, Auto AnswerOperation, formore

information on CIM callout and THS 2000 software auto

answer features.

Note: CIM versions prior to Version 3.0 did not support

the call-all-numbers feature; this option is

grayed-out for those devices. Also, in older CIM

versions, all the phone numbers shared the same

number of attempts; this is reflected in this dialog

box by tying all the attempts choices together, so

if one is changed, they are all changed.

Modbus� is a trademark of Schneider Electric.
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Figure 25 CIM Callout

CIM Database

All the properties of the CIM described in this section are

stored in an internal database. This database, and

therefore the CIM properties, can be reset to factory

default values by initializing the database. The

command to initialize the database can be found in the

CIM Database tab of the Current Site Properties dialog

box, as shown in Figure 26.

Note: This feature is provided as a last resort. It should

not be invoked unless you know what you are

doing or you are under the guidance of a qualified

service person.

Figure 26 CIM Database

CIM Port 2

A CIM connected directly to a PC host or a

Programmable Logic Controller (PLC) is connected

serially to Port 2. The serial connection parameters are

under the CIM Port 2 tab of the Current Site Properties

dialog box, as shown in Figure 27.

The signal type indicates the type of physical connection

between the host and CIM. The RS-232/Modem option

indicates that a connection is via a standard RS-232

cable or the internal modem (CIM Port 1). The RS-422

and RS-485 options are for multi-drop networks. The

auto-detect optionwill allow theCIM to attempt to decide

for itself which physical connection is in use. The default

signal type is auto-detect.

The other parameters are standard serial type

parameters, including parity, data bit size, stop bits, and

baud rate. The baud rate values can be 1200, 2400,

4800, 9600, 14400, and 19200. The receive timeout

parameter describes the amount of time after receiving

the last byte of the packet until the packet is processed

internally.

The Restore Defaults button will restore all parameters

to their initial values (no parity, 8 data bits, 1 stop bit,

9600 baud, and 20 millisecond receive timeout.

The Fixed Modbus� Mode option is for enabling the

fixed Modbus�mode for operation with a PLC. Once in

fixed Modbus� mode, the CIM no longer requires a

Modbus� is a trademark of Schneider Electric.
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password to logon, it is essentially always logged in to

save the PLC fromhaving to do so. All modem functions

are disabled when in fixed Modbus� mode as well, to

prevent unauthorized remote access. The only way to

disable fixed Modbus� mode is to connect directly (via

RS-232 or RS-485) with the THS 2000 software, which

will disable fixed Modbus� mode when attempting to

log in to the CIM.

Note: The receive timeout and auto-detect signal type

features were not supported in previous versions

of the CIM and, therefore, their values appears

grayed-out and read only when examined by the

THS 2000 software.

The protocol used on Port 2 is Modbus�, as described

in Section 3, CIM Protocol.

Figure 27 CIM Port 2

CIM Port 3

The Port 3 of the CIM is used to communicate with the

controllers on the site. The parameters for this port can

be found under the CIM Port 3 tab in the Current Site

Properties dialog box, as shown in Figure 28.

These values are currently read only; you may not

change any of these values, they are fixed.

Figure 28 CIM Port 3

CIM Advanced

The CIM Advanced tab of the Current Site Properties

dialog box allows you to change some of the more

advanced features of the CIM, such as Modbus�

characteristics and controller polling. The dialog box is

shown in Figure 29.

The top box contains properties unique to theModbus�

operation of theCIM (see Section 3, CIMProtocol). The

Slave ID is the ID used by the PLC to reference the CIM;

the valid range for a Modbus� slave device is 1-247.

The Poll Bounds parameters are for changing the

behavior of the controller discovery polling. Controllers

have an address range of 1 to 255, but there is a limit of

10 controllers per site. The Poll Bounds parameters

reduce the range of addresses that the CIM must poll in

order to discover new devices. Reducing this range to

the expected values of the controllers, such as 1 to 10,

speeds up response time.

The Response Delay parameter dictates the amount of

time, in milliseconds, to wait before sending a response.
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Note: The advanced features described here are only

supported in CIM Version 3.0. When THS 2000

software is communicating with an older CIM, the

CIM Advanced dialog box is not available.

Figure 29 CIM Advanced

2.6.5 Controller Configuration

This section deals with the adding and removing of

controllers. The controller currently supported by the

THS 2000, and the CIM is the TSC 800 transfer switch

controller.

Controller Discovery

The THS 2000 Version 3.0 software, in conjunction with

the CIM Version 3.0, supports automatic controller

discovery. When THS 2000 software establishes a

connection to a remote CIM, it interrogates the CIM for

the list of controllers present on this site. The user is

then prompted to accept this list of controllers or

continue with the controllers already loaded.

Versions of the CIM prior to Version 3.0 do not support

the controller discovery, and controllers must be added

manually as explained next in Adding A Controller.

Adding A Controller

Selecting the Add option from the Controller menu

allows you to add a TSC 800 controller to the site from

the Add Controller dialog box, as shown in Figure 30.

TSC 800

Figure 30 Add Controller Dialog Box

The controller address can be between 1 and 255, with

no duplicates allowed. The controller type is TSC 800.

The description can be any descriptive text you wish.

Removing A Controller

Removing a controller is accomplished by selecting the

Remove item from the Controllermenu which brings up

the Remove Controller dialog box, as shown in

Figure 31.

The controller to be deleted is selected from the list

presented.

Figure 31 Remove Controller Dialog Box

Controller Properties

A controller’s properties can be examined by selecting

the Properties item of the Controller menu. This brings

up a menu from which you can choose the controller to

be examined, as shown in Figure 32.
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Figure 32 Controller Properties

After the controller is selected and the OK button is

clicked, the TSC 800 dialog box is presented. From this

window, the description can be modified and other

properties, such as the controller address and the fault

labels, can be viewed.

The TSC 800 properties dialog box is shown in

Figure 33. From here, the controller description can be

modified. Additional properties, such as the controller

address, can be viewed.

Figure 33 TSC 800 Properties

2.6.6 Auto Answer Configuration

An important feature of remotemodem sites is the ability

to dial the host and report an alarm condition. The host

site can be configured from the Auto Answer Settings

command of the Site menu, as shown in Figure 34.

When the auto answer feature is enabled, the THS2000

software will accept calls from any site in the currently

loaded site list.

Figure 34 Auto-Answer Settings

2.7 Operation

2.7.1 Basics

This section describes the basic functionality of the

THS 2000 software, from logging on to user interface to

accessing the online help. SeeSection 2.5, Quick Start,

for a fast get-up-and-running breakdown.

Starting And Logging On

Double clicking the THS 2000 icon starts the THS 2000

software. A splash screen indicating the version and

related information is displayed for a short period. You

will then be prompted to enter a password, as shown in

Figure 35.

Figure 35 Enter Password
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The THS 2000 software logon process allows for three

different levels of security, depending on the password

you entered. The levels are read only, read/write, and

master (see Section 2.6.1, Passwords, for more

information).

You also have the option of selectingDemomode,which

allows you to create some simulated controllers and

otherwise operates as if you had read only security

privileges.

The Interface

Themain THS 2000 interface is shown in Figure 36. It is

a relatively standard Windows-based application with a

title bar, main menu, toolbar, and status bar, as well as a

controller bar and a special viewing area.

TSC 800

TSC 800

TSC 800

Figure 36 Main THS 2000 Interface

Title Bar

The title bar displays the currently loaded site list file.

The site list file is a collection of one or more generation

sites that has been configured and saved previously.

The site list file can be opened, saved, and printed from

the main menu or toolbar. The THS 2000 software site

list files have the file extension .THS.

Main Menu

The main menu provides access to the THS 2000

software commands. Some commands are available

only under certain circumstances; when the command

is not available, it is grayed-out. For example, you will

not be able to add a controller (Add from the Controller

menu) until you have created an initial site (Connect

from the Site menu or New from the File menu).

Themainmenu commands are also available using ALT

key combinations; the underlined character indicates

the key to press in combination with the ALT key. Many

of the important commands are available using function

keys; these are indicated in the pulldown menus.

Toolbar

The toolbar provides instant access to many important

menu commands. When the mouse pointer is floated

over the tool item, a tool tip is displayed in the status line

portion of the status bar.

Controller Bar

The controller bar contains a button called List and a

button for each controller on the site. The controller

buttons are labeled using the controller’s identification

number (ID). Pressing a button on the controller bar will

change the view to display the selected controller or the

controller list view.

When the selected site is connected, the dot in the

middle of the controller bar button will indicate the status

of the controller (green, yellow, red, or black).

Status Bar

The status bar displays status messages and indicates

connection status and security status. The status line



TT-1409 6/05 23

displays tool tips and various status messages. The

connection status indicates the state of the current

connection, such as Idle or Connected to EastWing. The

security status indicates with which security level you

have logged on.

View

The view area displays one of two different views. The

list view shows a tabular list of the controllers on the

selected site. The controller view displays data from the

TSC 800.

Accessing Help

The command Contents from the Help menu, the

toolbar button, or the F1 key will bring up an online

reference.

Exiting

The Exit command from the File menu will exit

THS 2000, disconnecting any outstanding connections.

2.7.2 Connecting Sites

A site is made up of a single CIM connected to one or

more controllers. Connecting to a site is the same as

connecting to a CIM. From the user’s point of view, the

CIM is the site. This section describes how sites are

connected and disconnected, as well as various

properties of the CIM and the host connection.

Only a single site from the site list can be connected at a

time.

Connecting A Site

A site can be connected using the Connect command

from the Site menu, the toolbar button, or the F9 key.

This will bring up the Connect To dialog box depicted in

Figure 37.

Figure 37 Connect to Dialog Box

This dialog box lists each site contained in the currently

loaded site list and allows you to select the site to which

a connection is desired. Clicking theConnect buttonwill

initiate a connection attempt. In addition, double

clicking on the site name will initiate a connection

attempt.

In addition, sites can be added to or removed from the

site list or simply have their properties modified. A

button labeled Connect Using is provided to jump to the

host connection settings (see Host Connection in

Section 2.6.3).

Disconnecting A Site

Selecting theDisconnect command from the Sitemenu,

the toolbar button, or the F10 key will disconnect the

currently connected site. This includes hanging up the

phone line for a modem connection.

2.7.3 Viewing And Commanding Controllers

The main function of the CIM is to facilitate

communication to the controllers present on the site.

The controller currently supported by the CIM is the

TSC 800 transfer switch controller. Themain view of the

THS 2000 software provides a simulated front panel of a

single controller.

Controllers can be added, removed, and examined from

menu commands.

Controller Views

The bulk of the THS 2000 software window is the view

area. This area can be a simple list of the controllers or a

more detailed representation of a single controller. The

controller bar buttons are used to select the desired

controller or the controller-list (see also The Interface in

Section 2.7.1).

The controller bar contains a button called List and a

button for each controller on the site. The controller

buttons are labeled using the controller’s ID. Pressing a

button on the controller bar will change the view to

display the selected controller or the controller list view.

When the selected site is connected, the dot in the

middle of the controller bar button will indicate the status

of the controller (green, yellow, red, or black).
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Figure 38 shows the view of a TSC 800 connected to a

remote CIM. The black part of the view is a direct

emulation of the TSC 800 front panel. The faults and

values are displayed and updated frequently.

Figure 38 THS 2000 Main View

Controller Commands

The controller can also be commanded to perform

control functions remotely. The control functions can be

found under the TSC 800 Command item of the

Controller menu. The commands for the TSC 800 are

shown in Figure 39.

Figure 39 TSC 800 Commands

2.7.4 Printing

Using the print command (the Print item from the File

menuor the toolbar button)while viewing a controller will

print the currently displayed values in a simple text

format. The print command will print the list of

controllers when invoked while viewing the controller

list.

2.7.5 Auto Answer Operation

When a remote CIM senses that a controller desires a

Callout, it will start the calling out sequence. The CIM

will dial its stored phone numbersX amount of times until

it makes a connection (see CIM Callout in

Section 2.6.4). The site where the CIM belongs must

currently exist in the site list of the THS 2000 software

program.

When an auto answer connection is established, an

event is registered in the Auto Answer dialog box, as

shown in Figure 40, and logged in the auto answer log

file (see Section 2.6.6, Auto Answer Configuration).

Figure 40 Auto Answer Dialog Box

When a site has connected, it will remain connected for

twominutes just as if connected by the operator. During

this time, the operator can view the controllers and

determine the cause of the alarm. The status bar will

also display a countdown of the remaining connection

time in seconds.

2.8 CIM Bypass Wiring

The CIM bypass connection mode of operation has a

different wiring scheme than a standard CIM

connection. The two possible methods of connection

are:

1. Direct. From computer to controller. The direct

connection bypass mode is shown in Figure 41.

2. Modem. From computer to local modem to remote

modem to controller. The modem connection

bypass mode is shown in Figure 42.
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Figure 41 Direct Connection

Figure 42 Model Connection

An RS-232 to RS-422 converter is required to convert

the signal from the computer or modem. The required

wiring from the RS-422 side of the convert to the RJ-45

connection on the controller is as shown in Figure 43.

Figure 43 Wiring, RS-422 to RJ-45

The RS-232 NULL connection between the modem and

the converter must pass all handshake signals, as

shown in Figure 44.

The modem must store configuration in a nonvolatile

storagemedium (such as FLASH). Themodemmust be

configured for the following features:

� Auto answer.

� Connect at 4800 bps only (no fallback).

� Echo disabled.

� No error correction.

� No compression.

Figure 44 Null Connection, Model--Converter
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All RS-232 to RS-422 converters and modems are not

created equal. The recommended parts are: 3Com

USRobotics V.90 56K Faxmodem and B&B Electronics

RS-232/RS-485 Converter Model 485PTBR (also an

RS-422 converter). Configure the modem prior to

operation with the DIP switches set as shown in

Figure 45 and the following initialization strings:

AT Q0 E0 V1 X4 &K0 &D0 &M0 &B0 &H0 &R1 &N4

AT S0=1

AT &W0

Switch Position

1 DOWN

2 UP

3 DOWN

4 DOWN

5 UP

6 UP

7 UP

8 DOWN

DOWN is on.

Figure 45 Modem Configuration

2.9 THS 2000 Troubleshooting

Symptom Corrective Action

Cannot communicate
with the site.

See Section 1.9, CIM
Troubleshooting, for possible
solutions.

THS 2000 software
locks up.

The Host software may lock-up if auto
answer mode is on when running in
direct mode; the Host software is
trying to write to a modem when it
may not be present. The solution is to
disable auto answer (see Section2.6.6
Auto Answer Configuration).

Unable to view online
help: The THS 2000
help file (THS3v0.chm)
could not be located.

Check that Microsoft Internet Explorer
4.01 or later is installed.

Ensure that the THS3v0.CHM file is
located in the same directory as the
THS3v0.EXE file.

Unable to view online
help: Unable to load a
file called hhctrl.ocx.

You need to run the hhupd.exe file
included with the THS 2000 software
distribution diskettes.
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3 CIM Protocol

3.1 Introduction

This protocol document is applicable to Version 3.0 of

the Communication Interface Module.

The Communication Interface Module (CIM) provides

the hardware and software interface between a

Modbus� compliant master device (customer-

supplied) and the specific Remote Terminal Units

(RTUs) as used at a generator site.

The RTU in this context is a device that directly operates

the equipment at a generator site. These devices are

the actual microprocessor-based controllers and

includes the TSC 800 transfer switch controller.

Note: This instruction manual provides detailed

information on the CIM 3.0 Modbus� protocol.

For detailed information on the CIM 3.0 hardware

and installation, see Communication Interface

Module. For information on operating CIM 3.0

using the THS2000 3.0 software program, see

Section 2, THS 2000 Software Program. For

more information on specific RTU devices, refer

to their associated instruction manuals.

For more information on theModbus� protocol, visit the

Modicon web site at www.modicon.com. The

communications protocol is split into the physical layer,

the datalink layer, and the application layer.

3.2 Physical Layer

At the physical layer, the CIM device is connected to a

Modbus� master through CIM Port 2 (DB-9 or RJ-45)

which is configurable to RS-232/-485/-422 and up to

19200 baud.

The TSC 800s connect to the CIM (host) through an

RS-422 interface via an RJ-45 connector to CIM port 3b.

Up to 10 remotes can be connected to a single CIM

(host), as shown in Figure 46.

The remote’s receive lines are always enabled. The

remote’s transmit lines are only enabled while

transmitting.

There is no hardware flow control.

Host Remote

Remote

Rx+

Rx--

Tx--

Tx+

GND

(NC)

(NC)

(NC)

Rx+

Rx--

Tx--

Tx+

GND

(NC)

(NC)

(NC)

1

2

3

4

5

6

7

8

1

2

3

4

5

6

7

8

Figure 46 Connections, CIM (Host) to TSC 800

Controllers (Remotes)

3.3 Datalink Layer

Note: Unless noted otherwise, all fields described in

this document contain unsigned binary data

stored in big-endian (most significant byte first)

format. Any unused fields contain zeroes. When

describing the fields, FALSE equals zero and

TRUE equals nonzero.

At the Datalink Layer, the host (master) is responsible

for polling the CIMs. The host sends request packets to

the remotes, and the remotes respond with response

packets. The communication format describes an

interface with the CIM database.

Unfortunately due to processing limitations, response

packets from the CIM to the host can have up to 25 ms

gaps in the data. TheCIM response data is shifted out in

16 character increments. In some cases, it can take up

to 25 ms to shift out the next 16 character buffer.

The host pretransmit delay is theminimum time required

between the reception of the last byte of a frame

(response) and the transmission of the first byte of a new

frame (request). The values in Figure 47 show the

necessary pretransmit delays to ensure reliable

transmission of data to the CIM.

Modbus� is a trademark of Schneider Electric.
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Baud Rate Delay (ms)

1200 130

2400 80

4800 40

9600 30

14400 30

19200 30

Figure 47 Pretransmit Delays

The typical CIM andTSC 800 data is accessible through

direct register read and writes.

3.3.1 Preset Multiple Registers (Type 16)

The preset multiple registers packet is used to write

specific values to the controllers. Numeric values are

shown in hexadecimal. For CRC Calculation, see

Section 3.15. The packet format for this request is

shown below.

ss 10 aaaa pppp bb rrrr....rrrr cccc

ss

CIM 20 ID (00 to FF)

aaaa

Starting register (4aaaa)

pppp

Register count (number of points)

bb

Number of bytes (register count x 2)

rrrr

Register data (16 bit data)

cccc

CRC-16 (see CRC Calculation)

Preset Multiple Registers Response

The response to this packet is shown below.

ss 10 aaaa pppp cccc

ss

CIM 20 ID (00 to FF)

aaaa

Starting register (4aaaa; same number as the write
packet)

pppp

Register count (same number as the write packet)

cccc

CRC-16 (see CRC Calculation)

Example: Remote Key Press Operation

SEND:

ss 10 0200 0001 02 kknn cccc

ss

CIM 20 ID (OO to FF)

kk

Keystroke number

nn

Number of times to repeat keystroke

cccc

CRC-16 (see CRC Calculation)

RECEIVE:

ss 10 0200 0001 cccc

ss

CIM 20 ID (OO to FF)

cccc

CRC-16 (see CRC Calculation)

It is also recommended to follow up with a Display Valid

Flag read to ensure the operationwas successful before

proceeding. The CIM does attempt multiple operations

in the case of a bad packet. However, if theDisplayValid

Flag is not valid after 900 ms, a retry should be

performed.

3.3.2 Read Holding Registers (Type 3)

The read holding register request is used for read data

from the controller. Numeric values are shown in

hexadecimal.

Read Holding Registers Request

Field addressing is done with the following format:

ss 03 aaaa pppp cccc

ss

CIM 20 ID (OO to FF)

aaaa

Starting register (4aaaa)

pppp

Register count

cccc

CRC-16 (see CRC Calculation)
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Read Holding Registers Response

ss 03 bb rrrr....rrrr cccc

ss

CIM 20 ID (OO to FF)

bb

Response byte count (register count x 2)

rrrr

Register data (16 bit data)

cccc

CRC-16 (see CRC Calculation)

Example: Read Registers 200 To 201

SEND:

ss 03 0200 0002 cccc

ss

CIM ID (OO to FF)

cccc

CRC-16 (see CRC Calculation)

RECEIVE:

ss 03 04 aaaa bbbb cccc

ss

CIM ID (OO to FF)

aaaa

Register 200 data

bbbb

Register 201 data

cccc

CRC-16 (see CRC Calculation)

3.4 Application Layer

At the application layer, the master controller sends

request messages to the CIMs, and the CIMs respond

with responsemessages. The only time the user needs

to be concerned with the CIM is when CIM configuration

parameters need to be modified.

The CIM port configuration table is used to change the

port type (RS-232/-485/-422) and data protocol options

such as baud rate, start bits, stop bits, and parity. The

CIM port configuration table consists of 2 records that

define CIM port 2 and port 3 options.

All register values are in hexadecimal notation. With

certain Modbus� interfaces youmay be required to use

a decimal value. In Modbus� terminology, a zero does

not exist in the decimal register list; therefore, many

PLC/ software interfaces may require you to convert the

Hex to decimal and then add one. (Example: 100Hex

—> 257 not 256). The actual packet will include the

below listed value with the 4 chopped off. The 4xxxx is

another Modbus� terminology that is not used in the

actual protocol, only the lower 4 digits are converted and

used in the packet description.

Values in bold typeface are the default values for their

respective fields.

3.5 Data Types And Formats

Figure 48 describes the possible return data types and

formats for Modbus� registers defined in the CIM.

A register data value consists of two bytes: the most

significant (MSB) and the least significant (LSB). Data

values are arranged with the MSB first (called

big-endian).

Data
Type

Register
Count

Maximum
Range Description

Boolean 1 0 or nonzero Boolean value: 0 = false, nonzero = true

Enum 1 0 to max-range Enumeration: range from 0 to some maximum

Uint8 1 0--255 Unsigned 8-bit integer (allowable values can be further limited)

Uint16 1 0--65535 Unsigned 16-bit integer (allowable values can be further limited)

String n Special Character (0--255) string, ordered: MSB1, LSB1, MSB2, LSB2, ...

Struct n Special
Structure; definition depends on register range; ordered: MSB1 = byte0, LSB1 = byte1,
MSB2 = byte2, LSB2 = byte3, ...

Figure 48 Data Types

Modbus� is a trademark of Schneider Electric.
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3.6 CIM Port Configuration

The Modbus� Configuration table in Figure 49 is used

specifically to assign a node address (CIM ID) to the

individual CIM unit. This is used in multiple CIM

configurations. The CIMs are slaves to any device

connected to Port 2. However, the CIM acts like a

Master to anything connected to Port 3. Communication

to the individual remotes will be done by communicating

to the CIM.

Field
Register
(Decimal)

Address
(Hex)

Register
Count

Data
Format Value

Port#2 Bitrate 40257 100 1 enum
0 = 57600, 1 = 38400, 2 = 19200, 3 = 14400, 4 = 9600, 5 =
4800, 6 = 2400, 7 = 1200

Port#2 Bits/char 40258 101 1 uint8 7 to 8 (8)

Port#2 Stopbits 40259 102 1 uint8 1 to 2 (1)

Port#2 Parity 40260 103 1 enum 0 = Odd, 1 = Even, 2 = None, 3 = Mark, 4 = Space

Port#2 Rx Timeout 40261 104 1 uint16 0 to 65535 (20)

Port#2 Line
Protocol 40262 105 1 enum 0 = RS-232, 1 = RS-422, 2 = RS-485, 3 = auto-detect

Port#3 Bitrate 40289 120 1 enum
0 = 57600, 1 = 38400, 2 = 19200, 3 = 14400, 4 = 9600, 5 =
4800, 6 = 2400, 7 = 1200

Port#3 Bits/char 40290 121 1 uint8 7 to 8 (8)

Port#3 Stopbits 40291 122 1 uint8 1 to 2 (1)

Port#3 Parity 40292 123 1 enum 0 = Odd, 1 = Even, 2 = None, 3 = Mark, 4 = Space

Port#3 Rx Timeout 40293 124 1 uint16 0 to 65535 (40)

Port#3 Line
Protocol 40294 125 1 enum 0 = RS-232, 1 = RS-422, 2 = RS-485

Figure 49 Modbus� Configuration Table

3.7 CIM General Configuration

The CIM ID is only used for programming CIM features,

it is transparent when communicating with the

TSC 800s.

The Poll Bounds structure has the following format:

byte 0 = upper bound; default 255

byte 1 = lower bound; default 0.

Field Register (Decimal) Address (Hex) Register Count Data Format Value

CIM ID 40321 140 1 uint8 0 to 255 (1)

CIM response delay (ms) 40322 141 1 uint16 0 to 5000 (30)

Poll bounds 40323 142 1 struct see below

Call out enable 40324 143 1 boolean
0 = disabled,
1 = enabled

Call out mode 40325 144 1 enum
0 = connect once,
1 = connect to all

3.8 CIM Passwords

Field
Register
(Decimal)

Address
(Hex)

Register
Count

Data
Format Value

Site Name 40337--40345 150--158 9 String Max-length = 18 bytes

THS mode password 40346--40354 159--161 9 String Max-length = 18 bytes

Modbus� mode password 40355--40363 162--16A 9 String Max-length = 18 bytes

3.9 CIM Login

Field
Register
(Decimal)

Address
(Hex)

Register
Count

Data
Format Value

Requested link protocol 40385 180 1 enum 0 = THS, 1 = Modbus�, 2 = Fixed-Modbus�

Requested line protocol 40386 181 1 enum 0 = logoff, 1 = RS-232, 2 = RS-422, 3 = RS-485,
4 = modem

Login request password 40387--40395 182--18A 9 string Max-length = 18 bytes

Modbus� is a trademark of Schneider Electric.
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3.10 CIM About

Field
Register
(Decimal)

Address
(Hex)

Register
Count

Data
Format Value

Device Type identifier 40417 1A0 1 enum Value = 0xC53A

4 character device name 40418--40419 1A1--1A2 2 string max-length = 4 bytes; ”CIM3”

Call out requested 40420 1A3 1 boolean 1 = call out requested

Serial Number (64bit binary) 40421--40424 1A4--1A7 4 struct structure--length is 8 bytes; value is factory set

THS software version (upper) 40425 1A8 1 uint16 0 to 65535

THS software version (lower) 40426 1A9 1 uint16 0 to 65535

THS protocol version (upper) 40427 1AA 1 uint16 0 to 65535

THS protocol version (lower) 40428 1AB 1 uint16 0 to 65535

Modbus� software version (upper) 40429 1AC 1 uint16 0 to 65535

Modbus� software version (lower) 40430 1AD 1 uint16 0 to 65535

Modbus� protocol version (upper) 40431 1AE 1 uint16 0 to 65535

Modbus� protocol version (lower) 40432 1AF 1 uint16 0 to 65535

3.11 CIM RTU List

The slave address and type are encoded in the following

2-byte structure:

Byte 0 = slave type (0 = none, 2 = TSC 800)

Byte 1 = slave address (0 to 255).

Field
Register
(Decimal)

Address
(Hex)

Register
Count

Data
Format Value

Reason for last callout 41281 500 1 enum 0 = RTU requested callout,
1 = RTU removed,
2 = RTU added,
3 = bad slave response

Slave 1 address and type 41282 501 1 struct see below

Slave 2 address and type 41283 502 1 struct see below

Slave 3 address and type 41284 503 1 struct see below

Slave 4 address and type 41285 504 1 struct see below

Slave 5 address and type 41286 505 1 struct see below

Slave 6 address and type 41287 506 1 struct see below

Slave 7 address and type 41288 507 1 struct see below

Slave 8 address and type 41289 508 1 struct see below

Slave 9 address and type 41290 509 1 struct see below

Slave 10 address and type 41291 50A 1 struct see below

3.12 CIM Callout

Field
Register
(Decimal)

Address
(Hex)

Register
Count

Data
Format Value

Phone number 1 41537--41553 600--610 17 string Max-length = 34 bytes

Callout attempts count 1 41554 611 1 uint8 0 to 9 (3)

Phone number 2 41555--41571 612--622 17 string Max-length = 34 bytes

Callout attempts count 2 41572 623 1 uint8 0 to 9 (3)

Phone number 3 41573--41589 623--634 17 string Max-length = 34 bytes

Callout attempts count 3 41590 635 1 uint8 0 to 9 (3)
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3.13 TSC 800 Register Tables

Specific TSC 800 data is received by addressing the

TSC 800 and accessing the appropriate registers listed

below. Using a TSC 800 address of 0 will cause all

TSC 800s to respond to the request. This is usually

reserved for communication with a single TSC 800 with

an unknown address. Otherwise TSC 800 addresses

range from 1--255; however, only ten RTUs (TSC 800)

can be connected to an individual CIM.

Field
Register
(Decimal)

Address
(Hex)

Register
Count

Data
Format Value

TSC 800 Key Press (write only reg) 41025 400 1 uint16 See TSC 800 Press Key

TSC 800 Valid Data/Display 41026 401 1 uint8 See TSC 800 Valid Data/Display

TSC 800 Version 41027--41029 402--404 3 struct See TSC 800 Get Version

TSC 800 Summary 41030--41036 405--40B 6 struct See TSC 800 Get Summary

TSC 800 Analog Group 41037--41049 40C--418 13 struct See TSC 800 Get Analog Values

TSC 800 Display Group 0 41050--41057 419--420 8 string See TSC 800 Display Details

TSC 800 Display Group 1 41058--41065 421--428 8 string See TSC 800 Display Details

3.14 TSC 800 Messages (Version 1.0)

The following sections describe in detail the data

registers mentioned in Section 3.13. For single byte

data the actual byte location in the registers is included

in the above mentioned tables.

3.14.1 TSC 800 Press Key

This message is used to remotely press a key on a

TSC 800s front panel. It is also used to get the

characters displayed on a TSC 800s LCD. The request

message has the following data bytes:

Field Description

Byte 0 This field contains the key, as follows:

0 = Null (This value is used to get the characters
displayed on the LCD without pressing any of the keys).

1 = Lamp test

2 = Previous

3 = Decrement

4 = Increment

5 = Next

6 = No manual test

7 = Manual offload test

8 = Manual onload test

9 = Escape from program menu

10--255 = Unused

Byte 1 This field contains the number of times the key is to be
pressed.

The response message contains the current display

contents.

3.14.2 TSC 800 Valid Data/Display

The data/display valid byte (byte 1, LSB) is used to

determine the following.

1. If bit 0 is set (1), the Current Data in the registers is

valid.

2. If bit 1 is set (1), the Display Data is valid (i.e. the

last Keypress command has executed

successfully).

3.14.3 TSC 800 Get Version

Thismessage is used to get the version information from

a TSC 800. The request message does not have any

data bytes. The response message has the following

data bytes:

Field Description

Byte 0 *** PAD ***

Byte 1 This field contains the remote type, as follows:

1 = TSC 800

2--255 = Undefined

Byte 2 This field contains the major TSC 800 message format
version number.

Byte 3 This field contains the minor TSC 800 message format
version number.

Byte 4 This field contains the major software version number.

Byte 5 This field contains the minor software version number.
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3.14.4 TSC 800 Get Summary

This message is used to get the summary information

from a TSC 800. The request message does not have

any data bytes. The response message has the

following data bytes:

Field Description

Byte 0,
Byte 1

This field contains the summary bitmap, as follows:

Bit 15 contains TRUE if a callout is required.

Bit 14 contains TRUE if dual prime mode, and FALSE if
standard mode.

Bit 13 contains TRUE if Src2 prime, and FALSE if Src1
prime.

Bit 12 contains TRUE if a transfer switch failure has
occurred.

Bit 11 is unused in standard mode. This bit contains
TRUE if the Src1 Start output is enabled in dual prime
mode.

Bit 10 contains TRUE if the Src2 Start output is enabled.

Bit 9 contains TRUE if the Src1 Pretransfer output is
enabled.

Bit 8 contains TRUE if the Src2 Pretransfer output is
enabled.

Bit 7 contains TRUE if the Src1 Transfer output is
enabled.

Bit 6 contains TRUE if the Src2 Transfer output is
enabled.

Bit 5 contains TRUE if the Load On Src1 input is
enabled.

Bit 4 contains TRUE if the Load On Src2 input is
enabled.

Bits 3--0 are unused.

Byte 2 This field contains the test mode, as follows:

0 = None

1 = Switch offload test

2 = Switch onload test

3 = Switch off

4 = Manual offload test

5 = Manual onload test

6 = Auto offload test

7 = Auto onload test

8--255 = Unused

Byte 3 This field contains the system status, as follows:

0 = Src1 start delay

1 = Src2 start delay

2 = Src1 warmup delay

3 = Src2 warmup delay

4 = Pretransfer delay

5 = Finding neutral

6 = Neutral delay

7 = Transferring

8 = Transfer failed, press lamptest

9 = Posttransfer delay

10 = Src1 return delay

11 = Src2 return delay

12 = Src1 cooling

13 = Src2 cooling

14 = Src1 auto, Src2 auto

15 = Src1 auto, Src2 failed

16 = Src1 auto, Src2 normal

17 = Src1 auto, Src2 offload test

18 = Src1 auto, Src2 onload test

19 = Src1 auto, Src2 ready

20 = Src1 auto, Src2 running

Field Description

Byte 3 21 = Src1 auto, Src2 starting

22 = Src1 auto, Src2 switch off

23 = Src1 failed, Src2 auto

24 = Src1 failed, Src2 failed

25 = Src1 failed, Src2 normal

26 = Src1 failed, Src2 offload test

27 = Src1 failed, Src2 onload test

28 = Src1 failed, Src2 ready

29 = Src1 failed, Src2 running

30 = Src1 failed, Src2 starting

31 = Src1 failed, Src2 switch off

32 = Src1 normal, Src2 auto

33 = Src1 normal, Src2 failed

34 = Src1 normal, Src2 normal

35 = Src1 normal, Src2 offload test

36 = Src1 normal, Src2 onload test

37 = Src1 normal, Src2 ready

38 = Src1 normal, Src2 running

39 = Src1 normal, Src2 starting

40 = Src1 normal, Src2 switch off

41 = Src1 offload test, Src2 auto

42 = Src1 offload test, Src2 failed

43 = Src1 offload test, Src2 normal

44 = Src1 offload test, Src2 offload test

45 = Src1 offload test, Src2 onload test

46 = Src1 offload test, Src2 ready

47 = Src1 offload test, Src2 running

48 = Src1 offload test, Src2 starting

49 = Src1 offload test, Src2 switch off

50 = Src1 onload test, Src2 auto

51 = Src1 onload test, Src2 failed

52 = Src1 onload test, Src2 normal

53 = Src1 onload test, Src2 offload test

54 = Src1 onload test, Src2 onload test

55 = Src1 onload test, Src2 ready

56 = Src1 onload test, Src2 running

57 = Src1 onload test, Src2 starting

58 = Src1 onload test, Src2 switch off

59 = Src1 ready, Src2 auto

60 = Src1 ready, Src2 failed

61 = Src1 ready, Src2 normal

62 = Src1 ready, Src2 offload test

63 = Src1 ready, Src2 onload test

64 = Src1 ready, Src2 ready

65 = Src1 ready, Src2 running

66 = Src1 ready, Src2 starting

67 = Src1 ready, Src2 switch off

68 = Src1 running, Src2 auto

69 = Src1 running, Src2 failed

70 = Src1 running, Src2 normal

71 = Src1 running, Src2 offload test

72 = Src1 running, Src2 onload test

73 = Src1 running, Src2 ready

74 = Src1 running, Src2 running

75 = Src1 running, Src2 starting

76 = Src1 running, Src2 switch off

77 = Src1 starting, Src2 auto

78 = Src1 starting, Src2 failed

79 = Src1 starting, Src2 normal

80 = Src1 starting, Src2 offload test

81 = Src1 starting, Src2 onload test

82 = Src1 starting, Src2 ready

83 = Src1 starting, Src2 running

84 = Src1 starting, Src2 starting
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Field Description

Byte 3 85 = Src1 starting, Src2 switch off

86 = Src1 switch off, Src2 auto

87 = Src1 switch off, Src2 failed

88 = Src1 switch off, Src2 normal

89 = Src1 switch off, Src2 offload test

90 = Src1 switch off, Src2 onload test

91 = Src1 switch off, Src2 ready

92 = Src1 switch off, Src2 running

93 = Src1 switch off, Src2 starting

94 = Src1 switch off, Src2 switch off

95--255 = Unused

Byte 4,
Byte 5

This field contains the system status timer value (in
seconds).

Byte 6,
Byte 7

This field contains the fault state bitmap. Each bit
contains TRUE if the associated fault is active. The bits
are defined as follows:

Bits 15--8 are unused.

Bit 7 is Src2 overfrequency.

Bit 6 is Src2 underfrequency.

Bit 5 is Src2 overvoltage.

Bit 4 is Src2 undervoltage.

Bit 3 is Src1 overfrequency.

Bit 2 is Src1 underfrequency.

Bit 1 is Src1 overvoltage.

Bit 0 is Src1 undervoltage.

Byte 8,
Byte 9

This field contains the fault visible bitmap. Each bit
contains TRUE if the associated fault is visible. The bits
are defined as follows:

Bits 15--8 are unused.

Bit 7 is Src2 overfrequency.

Bit 6 is Src2 underfrequency.

Bit 5 is Src2 overvoltage.

Bit 4 is Src2 undervoltage.

Bit 3 is Src1 overfrequency.

Byte 8,
Byte 9

Bit 2 is Src1 underfrequency.

Bit 1 is Src1 overvoltage.

Bit 0 is Src1 undervoltage.

Byte 10 This field contains the day of the week of the system
time, as follows:

0 = Sunday

1 = Monday

2 = Tuesday

3 = Wednesday

4 = Thursday

5 = Friday

6 = Saturday

7--255 = Unused

Byte 11 This field contains the hour of the system time. Valid
values are 0--59.

Byte 12 This field contains the minute of the system time. Valid
values are 0--59.

Byte 13 This field contains the second of the system time. Valid
values are 0--59.

3.14.5 TSC 800 Get Analog Values

This message is used to get the analog values from a

TSC 800. The requestmessage does not have anydata

bytes. The response message has the following data

bytes:

Field Description

Byte 0, Byte 1 This field contains the analog values bitmap,
as follows:

Bit 15 contains TRUE if 3 phase mode, and
FALSE if 1 phase mode.

Bits 14--0 are unused.

Byte 2, Byte 3 This field contains the Src1 phase AB voltage
(in volts).

Byte 4, Byte 5 3 phase mode: This field contains the Src1
phase BC voltage (in volts).
1 Phase mode: This field contains the Src1
phase AN voltage (in volts).

Byte 6, Byte 7 3 phase mode: This field contains the Src1
phase CA voltage (in volts).
1 Phase mode: This field contains the Src1
phase BN voltage (in volts).

Byte 8, Byte 9 This field contains the Src1 frequency (in
tenths of hertz).

Byte 10, Byte 11 This field contains the Src2 phase AB voltage
(in volts).

Byte 12, Byte 13 3 phase mode: This field contains the Src2
phase BC voltage (in volts).
1 Phase mode: This field contains the Src2
phase AN voltage (in volts).

Byte 14, Byte 15 3 phase mode: This field contains the Src2
phase CA voltage (in volts).
1 Phase mode: This field contains the Src2
phase BN voltage (in volts).

Byte 16, Byte 17 This field contains the Src2 frequency (in
tenths of hertz).

Byte 18, Byte 19 This field contains the load phase AB voltage
(in volts).

Byte 20, Byte 21 This field is unused.

Byte 22, Byte 23 This field is unused.

Byte 24, Byte 25 This field contains the load frequency (in
tenths of hertz).
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3.14.6 TSC 800 Display Details

The display details are broken into two groups. Group 0

contains the 16 ASCII characters from the top line of the

TSC 800 display. Group 1 contains the 16 ASCII

characters from the bottom line of the display. There are

too many individual display messages to list here;

however, some basic messages should be described.

The two most useful messages are nonvalid and valid.

This is mainly used for confirmation that a keystroke has

been sent and received by the TSC 800 correctly. See

Figure 50 and Figure 51.

Field Description

Byte 0 to Byte 15 This field contains the ASCII characters from
the LCD top line.

Figure 50 Group 0

Field Description

Byte 0 to Byte
15

This field contains the ASCII characters from
the LCD bottom line.

Figure 51 Group1

3.15 CRC Calculation

The Cyclical Redundancy Check (CRC) calculation

used by Modbus� is commonly called the CRC-16

algorithm. Refer to A Painless Guide to CRC Error

Detection Algorithms by Ross N. Williams for more

detailed information. Using the terminology of that

paper, the CRC algorithm used by the CIM is:

Name : CRC--16

Width : 16

Poly : 8005

Init : FFFF

RefIn : True

RefOut : True

XorOut : 0000

Check : BB3D

The following is a C code implementation of the CRC-16

method:

unsigned short CalculateCrc(unsigned char *pAddress,

int nByteCount)

{

unsigned short wCrcValue = 0xffff;

while (nByteCount----)

{

wCrcValue ^ = *pAddress;

for (int i = 0; i < 8; i++)

{

if (wCrcValue & 1)

{

wCrcValue >> = 1;

wCrcValue ^ = 0xa001;

}

else

{

wCrcValue >> = 1;

}

}

pAddress++;

}

return wCrcValue;

}

Modbus� is a trademark of Schneider Electric.
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